
SPECIAL COLOR INK GUIDE
(Metallic Silver & White)

This document describes the characteristics of special color inks (white ink and metallic silver ink) used with 
XC-540MT, important notes, maintenance, and printing method using these inks. For other matters, refer to the 
XC-540/XC-540MT Setup Guide and the XC-540/XC-540MT User's Manual.

When using metallic silver ink and white 
ink, be sure to read this first.
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Thank you very much for purchasing this product.
 To ensure correct and safe usage with a full understanding of this product's performance, please be sure to 

read through this manual completely and store it in a safe location.
 Unauthorized copying or transferal, in whole or in part, of this manual is prohibited.
 The contents of this operation manual and the specifications of this product are subject to change without 

notice.
 The operation manual and the product have been prepared and tested as much as possible. If you find any 

misprint or error, please inform us.
 Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may occur through 

use of this product, regardless of any failure to perform on the part of this product.
 Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may occur with 

respect to any article made using this product.
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1-1  What This Document Assumes and Related Manuals

What This Document Assumes 
Before performing any operations described in this guide, make sure that all the following preparations are 
complete.
 Assembling and installing the XC-540MT unit
 Installing VersaWorks on your computer, and connecting the computer to the XC-540MT via a network

Related Manuals 
Read the following documentation for information about setting up the XC-540MT unit and VersaWorks.

(1) Setup Guide
This manual covers details about how to use the XC-540MT, including how to set up the printer and where to 
locate the printer, etc. Be sure to read this manual.

(2) User's Manual
This manual describes operation methods in detail. After you've read the XC-540MT Setup Guide, be sure to 
read this manual.

(3) VersaWorks Quick Start Guide
This manual explains basic operations of VersaWorks, including how to set up the program. Be sure to read 
Chapter 1 of this manual and make necessary setups on your computer. It is also recommended to read Chapter 
2 of this manual and become familiar with how to use this program.

VersaWorks Online
This document describes the important notes for using the metallic silver ink and white ink as well as the basic 
printing method. You can get the latest information about Roland VersaWorks and the information on printing 
methods requiring more complex settings by viewing VersaWorks Online.
If you want to learn more about the features of Roland VersaWorks, or if you want to use metallic silver ink and 
white ink more effectively, be sure to visit VersaWorks Online.
URL:  http://dg4.roland.co.jp/en/RVW2forWeb/index.html
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1-2  Before Starting Operations

Important: Characteristics of Inks and Important Notes
The usage and handling of white ink and metallic silver ink involve some important considerations that do 
not apply to ink of other colors.
Be sure to familiarize yourself with the characteristics of inks before you use it.

White ink and Metallic Silver ink settle and separate.

 If it is allowed to stand, the precipitated material may solidify and cause clogging of the print heads or 
other malfunction. Be sure to observe the cautions in this manual.

Maintenance must be performed.

 Always keep the main power switched on. If the main power is switched off, the automatic maintenance 
function stops working, and may result in malfunction.

 We recommend operating the printer at least once a week.
 If the printer is left unused for a long period of time, ink precipitation may occur, resulting in an incorrect 

ink discharge such as occurrence of dot drop-out. In such cases, the precipitated and solidified ink needs 
to be discharged. This work requires two SOL INK cleaning cartridges. For how to perform the work, refer 
to the description below.
 P. 64, "When Dot Drop-out etc. Cannot be Corrected"

Drying inks

 After output, allow the ink to dry sufficiently. Note that white ink and metallic silver ink in particular require 
printing at a high density, and so are more difficult to dry than CMYK inks.

 Use an auxiliary drying unit (DU-540).

We strongly recommend performing lamination.

 Depending on conditions, the weatherability of metallic silver ink and white ink may be inferior to that of 
CMYK inks. Therefore, laminating is strongly recommended.

 Maintenance requires two SOL INK cleaning cartridges, so be sure to have these on hand.

Before Starting the Day's Work
 Remove just the white and metallic silver ink cartridges, shake them gently, then reinsert 

them.
 The cyan, magenta, yellow, and black ink cartridges do not need to be shaken every day, but 

new cartridges for these colors should be shaken when you install them.

The ingredients in white and metallic silver ink tend to settle. Each day, before starting the day's operations, 
be sure to carry out the above steps. Allowing the ink to stand without carrying out these steps can cause the 
settled material to harden, resulting in malfunction or other problems.
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1-3  Important Notes on Printing

When Performing Pullback Printing

What is Pullback Printing?

Pullback printing refers to a printing method in which the white-ink (or metallic silver ink) undercoat is printed 
first, and then CMYK color is printed on top of white ink (or vice versa); in the process, the already printed 
media is pulled back to the original position once, and then overprinting is performed.

Allow the ink to dry thoroughly.

 Dry the ink sufficiently before you perform pullback printing with the next color. Performing pullback 
printing before the ink has dried enough may make attractive printing impossible or cause problems such 
as reduced weatherability.

 Drying time differs according to various conditions, but as a general guide you should use an auxiliary 
drying unit (DU-540) and also allow the media to stand for an additional 15 minutes.

 In particular, when you're pullback printing a white or metallic silver undercoat with CMYK inks, allow the 
undercoat to dry thoroughly before you overprint it. If the undercoat is not dry enough, differences in 
dryness may cause variations in the overprinted CMYK colors.

Using the middle pinch rollers

 The middle pinch rollers may smudge the printed surface when the media is pulled back. When you per-
form pullback printing, we recommend securing the media in place using only two pinch rollers (one on 
the left and one on the right).

Never use the media take-up system

 Performing pullback printing requires pulling the media back, and so the take-up unit cannot be used.

When Using Transparent Media

Loading transparent media

 Set the [EDGE DETECTION] menu item to "DISABLE". Transparent media cannot be loaded unless this set-
ting is made.

 Ensure a margin of at least 75 mm from the leading edge of the media to the printing- or cutting-start 
location.

Important notes on the amount of media remaining
 When you use transparent media, the presence of media cannot be detected. In such cases, printing opera-

tion does not stop when the media runs out, and there is a chance that the platen or the like may become 
soiled by ink or that ink may get inside and damage the machine.

 If media runs out while printing is in progress, immediately press  to quit printing.

Chapter 1  Getting Started
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Using the middle pinch rollers

 The middle pinch rollers damage media slightly, and on transparent media this damage can be very notice-
able. If such damage is a concern, we recommend securing the media in place using only two pinch rollers 
(one on the left and one on the right).

Automatic crop-mark detection

 Automatic crop-mark detection may not be possible for some media, such as transparent media. In such 
cases, perform alignment manually.

Chapter 1  Getting Started
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2-1  Preparing VersaWorks

Starting VersaWorks
On the computer you're using, start VersaWorks. For information on how to start the program, see the Roland 
VersaWorks Quick Start Guide. After starting the program, go to the upper left of the main screen and check to 
make sure that "Model (or Nickname) of Your Printer" is displayed, and that "Status" is set to "Ready to Print."

Creating a Folder for Saving PS Files
Before you actually print an image you draw using application software such as Adobe Illustrator, it is necessary 
to save the image as a PS file (s). And then, you can print the image by loading the PS file (s) on VersaWorks. 
Because of this, you should create a folder for saving PS files in advance. It is recommended to locate the folder 
in the root directory on your computer's local disk.

Procedure

 Open [Computer] (or  [My Computer]), and then open [Local Disk (C:)].

 On the [Organize] menu, click [New 
Folder]. (Or on the [File] menu, click 
[New], and then click [Folder].)

 Enter the name for the folder, and then 
press the Enter key.
Here you name "MT-WH_print", for example.
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2-2  Printer Preparations

Making the Printer Settings and Loading Media

When Using Transparent Media

When you're using transparent media, make the necessary printing settings on the printer and load the media 
accordingly.

Procedure

 Press and make the following settings.
[EDGE DETECTION] to "DISABLE."

 Load transparent media into the printer.
 When the media warps or partially floats, ensure a margin of about 200 mm from the leading edge of 
the media to the printing- or cutting-start location. 
 Be sure to use the media clamps when you load media.

When Using Media Other Than Transparent Media

Load the media using the method described in the XC-540/XC-540MT User's Manual.
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2-3  Creating Printing Data

Basic Approach for Creating Printing Data

When Using Metallic Silver Ink 

When you print using metallic silver ink, you can create the printing data according to the two methods 
below.
 Specify the spot color so as to use only the metallic silver ink.

Apply the spot color named "RDG_MetallicSilver" to the areas you want to print using the metallic silver 
ink.

 Use the exclusive metallic color special colors library.
From the exclusive metallic color special colors library, select the metallic color to be used which is the 

combination color of CMYK ink and metallic silver ink. 

When Using White Ink

Apply the spot color named "RDG_WHITE" to the areas you want to print using the white ink.

Creating Data for Printing
Create the data for printing using the metallic silver ink and white ink.
The program used to create the printing data is Adobe Illustrator CS3. For detailed information on drawing 
methods and how to work with palettes, refer to the documentation or online help for Adobe Illustrator 
CS3. If you're using another version of Adobe Illustrator, operations may be somewhat different from those 
explained here.

1. Open the exclusive swatch library.

 At the swatch palette menu, select [Open Swatch Library], then [Other Libraries].
The "Select Library" window appears.
NOTE:	 The swatch palette is displayed by going to the menu and selecting [Window], then [Swatch].
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 Open folder in the order of [Computer] (or [My Computer]) → [Local Disk (C:)] → 
[Program Files] → [Roland VersaWorks] → [Swatch] → [Illustrator], then select "Roland 
VersaWorks.ai."
Depending on the settings of your computer, the extension ".ai" might not be shown.

Click [Open].
The swatch library containing "RDG_MetallicSilver" and "RDG_WHITE" is displayed.

 Open the same folders as in step , then select "Roland Metallic Color.ai."
Depending on the settings of your computer, the extension ".ai" might not be shown

Click [Open].
The swatch library is displayed which is containing the "metallic color" created by mixing the metallic 
silver ink and CMYK ink.

By saving the ".ai" file selected in steps  and  into the folder below, you can register each swatch 
library to the Adobe Illustrator's library.
C:\Program Files\Adobe\Adobe Illustrator CS3\Preset\Swatch
("C" is the name of your computer's local disk.)
Once the registration is performed, you can open the library directly from the swatch palette menu, elimi-
nating the need to search the file every time you start Adobe Illustrator.
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2. Create the illustration, and specify the spot color that matches the color you want to print.

 Create the illustration.
Be sure to draw the illustration in the CMYK mode.

 Specify each spot color that matches the color you want to print.

Desired ink or color Spot color name

Metallic silver ink RDG_MetallicSilver
White ink RDG_WHITE
Metallic color
(Metallic silver/CMYK combination color)

RVW-MT-Silver, RVW-MT-Bronze, RVW-MT-
TitanBlack, etc.

Using the metallic silver ink, you can perform the blend print and the layered print by combining the 
ink with the CMYK ink.
 P. 18, “Blend Print and Layered Print (Metallic Silver and CMYK)”

Specify "RDG_WHITE" for 
the areas where you want to 
use white ink. Specify " RDG_MetallicSilver " for the 

areas where you want to use metallic 
silver ink.

Areas where you want to use metallic color
 From the metallic color special colors library (Roland Metallic 
Color), specify the color such as "RVW-MT-Bronze"
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3. Create the PS (PostScript) file.

 Select [Print] from the [File] menu.

Select [Roland VW].
When a nickname is set, or when more than one 
printer is connected, select “Roland VW_(the 
nickname of the printer used for output).”

Click [Setup].

Click [Continue].
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 Turn on the [Print to file] option.

Click [Preferences].

Click [Advanced] in the [Layout] tab.
For Windows 2000:	 In the "Print" 
dialog box (the window at the very top 
of this page), go to the "Layout" tab and 
click [Advanced].

Click the down arrow to the right of 
the [Paper Size] box, and then click 
[PostScript Custom Page Size] from the 
list that appears.

For "Custom Page Size Definition," 
enter the values in the "Width" and 
"Height" fields.
Enter values for the same size as the illustration 
you created in step 2.
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 Click [OK] three times to close the "PostScript Custom Page Size Definition," "Roland 
VersaWorks Advanced Options," and "Printing Preferences" dialog boxes. 
The "Print" dialog box returns.

 Click [Print].

Click [Print].

 Specify the destination and file name 
for saving, then save the file.
Example:	 " C:\MT-WH_print " for the folder to 
save to, and " mt-wh.ps " as the file name

Click [Save].
The CMYK layer of the image is saved as a PS 
file.

 Open the folder you saved to and make sure the file has been created.

Select the folder you created in "Creating 
a Folder for Saving PS Files" on page 10.

Assign the name you want. It may be a good idea to 
assign a name that indicates that the file uses white 
and metallic silver ink. 
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Blend Print and Layered Print (Metallic Silver and CMYK)
Using the metallic silver ink, you can perform the blend print and the layered print by combining the ink with 
the CMYK ink. By this means, you can realize the metallic expressions that cannot be made only with the CMYK 
ink. The printing methods are different between the blend print and the layered print, and so are the metallic 
impressions of the CMYK colors. Select and use the types of printing to suit your taste.

 P. 24, “Blend Print (Metallic Silver + CMYK),” p. 26, “Layered Print (Metallic Silver  CMYK),” p. 28, "Layered Print 
(CMYK  Metallic Silver )"

* When you perform “Printing with White, Metallic Silver, and CMYK Ink” (page 32), the printing method is 
limited to the blend print.

Blend Print

(Image of printing method)

In performing the blend print or the layered print, you can specify the colors from the metallic color 
special colors library. However, if you specify the metallic colors with the same names for the blend 
print and the layered print, the tones of the colors are different between them. We recommend that 
you check the tones of the colors by performing the test printing or printing out the Metallic Color 
Chart.
Seeing the metallic color chart for the layered print, you may feel a slight inconsistency between the 
names and the tones of the colors. This is because the colors listed in the Metallic Color Chart are 
named based on those for the blend print.
 P. 38, “Printing the Metallic Color Chart”

The metallic silver ink and the CMYK ink are blended 
to be a single layer for printing.

Media

Metallic Silver and  
CMYK
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Layered Print

(Image of printing method)

The metallic silver ink and the CMYK ink are separated into the different layers 
and printed in that order. (Metallic silver ink  CMYK ink)

The metallic silver ink and the CMYK ink are separated into the different layers 
and printed in that order. (CMYK ink  Metallic silver ink)

Media

Metallic Silver

CMYK

The printed image is to be 
seen from this side (the printed 
surface of the finished results).

CMYK

The printed image is to be seen from 
this side (the opposite side of the printed 
surface of the finished results).

Media

Metallic Silver
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3-1  Print Job Setting

Printing Only with Metallic Silver Ink
This section describes how to perform printing only with the metallic silver ink. To use the metallic silver ink 
in printing, you need to use the printing data where the use of the metallic silver ink is designated. If the 
printing data have the portion designating the use of other colors, with the settings described in this section, 
you can print with the metallic silver ink only the area of the image which has been designated to print with 
the metallic silver ink.

 P. 12, “2-3  Creating Printing Data”

Procedure

 Make sure that you have finished making the preparations for VersaWorks, getting the 
printer ready, and creating the printing data ( page 9, "Chapter 2 -- Getting Ready").

 Double-click .
Queue A Properties" window appears.

 Click .

For [Media Type], select names with [MT] 
attached such as "Generic Vinyl 1 [MT]".
Make the selection that matches the media to be 
used. Selecting an item attached with [MT] enables 
you to choose the print mode that can use the me-
tallic silver ink.

For [Print Quality], select [High Quality]

For [Mode], select [MetallicSilver (v)].
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 Click .

Turn on the [Convert Spot Color] option.

 Click .

In [Operation Mode], select the operation of 
the printer. 

 Click [OK] to close the "Queue A Properties" 
window. 

This is the end of the print job setting. To start printing, go on to page 37 “Starting the Print Operation.”

Only the settings necessary for the use of the metallic silver ink are described in this section. For other settings, 
refer to the online help provided for VersaWorks.

* If you select [CMYK (v)] for [Mode] in the procedure , only the area of the image where CMYK is specified 
in the printing data is to be printed.
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Blend Print (Metallic Silver + CMYK)
This section describes how to perform the blend print with the metallic silver ink and CMYK ink.

 P. 18, “Blend Print and Layered Print (Metallic Silver and CMYK)”
To perform the blend print, you need to use the printing data where the use of the metallic silver ink and the 
CMYK ink is designated.

 P. 12, “2-3  Creating Printing Data”

Procedure

 Make sure that you have finished making the preparations for VersaWorks, getting the 
printer ready, and creating the printing data ( page 9, "Chapter 2 -- Getting Ready").

 Double-click .
Queue A Properties" window appears.

 Click .

For [Media Type], select names with [MT] 
attached such as "Generic Vinyl 1 [MT]".
Make the selection that matches the media to be 
used. Selecting an item attached with [MT] enables 
you to choose the print mode that can use the me-
tallic silver ink.

For [Print Quality], select [High Quality].

For [Mode], select [CMYKMt (v)].
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 Click .

Turn on the [Convert Spot Color] option.

 Click .

In [Operation Mode], select the operation 
of the printer. 

 Click [OK] to close the "Queue A Proper-
ties" window. 

This is the end of the print job setting. To start printing, go on to page 37 “Starting the Print Operation.”

Only the settings necessary for the use of the metallic silver ink are described in this section. For other settings, 
refer to the online help provided for VersaWorks.
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Layered Print (Metallic Silver  CMYK)
This section describes how to perform the layered print with the metallic silver ink and CMYK ink using the 
metallic silver ink as background.

 P. 18, “Blend Print and Layered Print (Metallic Silver and CMYK)”
To perform the layered print, you need to use the printing data where the use of the metallic silver ink and 
the CMYK ink is designated.

 P. 12, “2-3  Creating Printing Data”

Procedure

 Make sure that you have finished making the preparations for VersaWorks, getting the 
printer ready, and creating the printing data ( page 9, "Chapter 2 -- Getting Ready").

 Double-click .
Queue A Properties" window appears.

 Click .

For [Media Type], select names with [MT] 
attached such as "Generic Vinyl 1 [MT]".
Make the selection that matches the media to be 
used. Selecting an item attached with [MT] enables 
you to choose the print mode that can use the me-
tallic silver ink.

For [Print Quality], select [High Quality 
(Layerd)].

If [Mode] is selectable, select [Mt -> CMYK 
(v)].
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 Click .

Turn on the [Convert Spot Color] option.

 Click .

In [Operation Mode], select the operation 
of the printer. 

 Click [OK] to close the "Queue A Proper-
ties" window. 

This is the end of the print job setting. To start printing, go on to page 37 “Starting the Print Operation.”

Only the settings necessary for the use of the metallic silver ink are described in this section. For other settings, 
refer to the online help provided for VersaWorks.
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Layered Print (CMYK  Metallic Silver )
This section describes how to perform the layered print with the metallic silver ink.

 P. 18, “Blend Print and Layered Print (Metallic Silver and CMYK)”
To perform the layered print, you need to use the printing data where the use of the metallic silver ink and 
the CMYK ink is designated.

 P. 12, “2-3  Creating Printing Data”

Procedure

 Make sure that you have finished making the preparations for VersaWorks, getting the 
printer ready, and creating the printing data ( page 9, "Chapter 2 -- Getting Ready").

 Double-click .
Queue A Properties" window appears.

 Click .

For [Media Type], select "xxx[MT]: Clear 
PET Film" or "xxx[MT]: PET Clear Film, 
Adhesive" (or xxx: Clear PET Film," "xxx: 
PET Clear Film, Adhesive).
* “xxx” indicates “ESP-CL” and others.

For [Print Quality], select [High Quality 
(Layerd)].

For [Mode], select [CMYK -> Mt (v)].
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 Click .

Turn on the [Convert Spot Color] option.

 Click .

In [Operation Mode], select the operation 
of the printer. 

 Click [OK] to close the "Queue A Proper-
ties" window. 

This is the end of the print job setting. To start printing, go on to page 37 “Starting the Print Operation.”

Only the settings necessary for the use of the metallic silver ink are described in this section. For other settings, 
refer to the online help provided for VersaWorks.

When You Want to Display the Side Opposite the Printed Surface by Using Clear Film.

Click .

Turn on the [Mirror] option.
When the printing data with mirror image 
is prepared beforehand, you do not need 
to turn on this option.

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


3-1  Print Job Setting

30 Chapter 3  Printing Chapter 3  Printing

Printing Only with White Ink
This section describes how to perform printing only with the white ink. To use the while ink in printing, you 
need to use the printing data where the use of the white ink is designated. If the printing data have the portion 
designating the use of other colors, with the setting described in this section, you can print with the white ink 
only the area of the image which has been designated to print with the white ink.

 P. 12, “2-3  Creating Printing Data”

Procedure

 Make sure that you have finished making the preparations for VersaWorks, getting the 
printer ready, and creating the printing data ( page 9, "Chapter 2 -- Getting Ready").

 Double-click .
Queue A Properties" window appears.

 Click .

For [Media Type], select “xxx[MT]: Clear 
PET Film” or “xxx[MT]: PET Clear Film, 
Adhesive”  (or xxx: Clear PET Film,” “xxx: 
PET Clear Film, Adhesive).
* “xxx” indicates “ESP-CL” and others.

For [Print Quality], select [High Quality].
When “xxx: Clear PET Film” or “xxx: PET Clear Film, 
Adhesive” is selected for [Media Type], [Print Quality] 
need not be selected (because the option is only 
[High Quality]). 
For [Mode], select [White (v)].
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 Click .

Turn on the [Convert Spot Color] option.

 Click .

In [Operation Mode], select the operation 
of the printer. 

 Click [OK] to close the "Queue A Proper-
ties" window. 

This is the end of the print job setting. To start printing, go on to page 37 “Starting the Print Operation.”

Only the settings necessary for the use of the metallic silver ink are described in this section. For other settings, 
refer to the online help provided for VersaWorks.

* If you select [CMYK (v)] for [Mode] in the procedure , only the area of the image where CMYK is specified 
in the printing data is to be printed.
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Printing with While, Metallic Silver, and CMYK Ink
This section describes how to perform printing with the metallic silver ink, the white ink, and the CMYK ink. 
Deciding which ink between the white and the others (the metallic silver and CMYK) you want to use for the 
base is an important point in determining the print job setting here.
To use the metallic silver ink and the white ink, you need to use the printing data where the use of the respec-
tive inks is designated. For the area of the image to be printed with the metallic silver ink and the CMYK ink 
combined, the setting is fixed to the blend print. 

 P. 12, “2-3  Creating Printing Data”

Procedure

 Make sure that you have finished making the preparations for VersaWorks, getting the 
printer ready, and creating the printing data ( page 9, "Chapter 2 -- Getting Ready").

 Double-click .
Queue A Properties" window appears.

 Click .

For [Media Type], select “xxx[MT]: Clear 
PET Film” or “xxx[MT]: PET Clear Film, 
Adhesive.”
* “xxx” indicates “ESP-CL” and others.

For [Print Quality], select [High Quality].
With [Mode], select the print mode.
White -> CMYKMt (v) 
Inks are overprinted in the sequence of white and 
then metallic silver/CMYK Color.
CMYKMt -> White (v)
Inks are overprinted in the sequence of white and 
then metallic silver/CMYK Color.

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


3-1  Print Job Setting

Chapter 3  Printing 33Chapter 3  Printing

Image of overprinting in the sequence of white and then metallic silver/CMYK Color
(Print Mode "White -> CMYKMt (v) ")

* The white data and the metallic silver/CMYK color data are actually printed simultaneously, but they are 
shown here as separate layers in order to indicate the printing sequence.

Image of overprinting in the sequence of metallic silver/CMYK Color and then white
(Print Mode "CMYKMt -> White (v) ")

* The white data and the metallic silver/CMYK color data are actually printed simultaneously, but they are 
shown here as separate layers in order to indicate the printing sequence.

The printed image is to 
be seen from this side 
(the printed surface of 
the finished results).

The printed image is to 
be seen from this side 
(the opposite side of the 
printed surface of the 
finished results).

Transparent film

White
Metallic silver/CMYK

Transparent film

White

Metallic silver/CMYK
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 Click .

Turn on the [Convert Spot Color] option.

 Click .

In [Operation Mode], select the operation 
of the printer.

 Click [OK] to close the “Queue A Proper-
ties” window.

This is the end of the print job setting. To start printing, go on to page 37 “Starting the Print Operation.”
Only the settings necessary for the use of the metallic silver ink and white ink are described in this section. For 
other settings, refer to the online help provided for VersaWorks.

When You Want to Display the Side Opposite the Printed Surface by Using Clear Film.

Click .

Turn on the [Mirror] option.
When the printing data with mirror image 
is prepared beforehand, you do not need 
to turn on this option.
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Printing with White and CMYK Ink
This section describes how to perform printing with the white ink and the CMYK ink. Deciding which ink 
between the white and the CMYK you want to use for the base is an important point in determining the print 
job setting here. To use the white ink for printing, you need to use the printing data where the use of the 
white ink is designated.

 P. 12, “2-3  Creating Printing Data”

Procedure

u Make sure that you have finished making the preparations for VersaWorks, getting the 
printer ready, and creating the printing data ( page 9, "Chapter 2 -- Getting Ready").

 Double-click .
Queue A Properties" window appears.

 Click .

For [Media Type], select “xxx: Clear PET 
Film” or “xxx: PET Clear Film, Adhesive.”
“xxx” indicates “ESP-CL” and others.

With [Mode], select the print mode.
White -> CMYK (v)
Inks are overprinted in the sequence of white and 
then CMYK Color.
CMYK -> White (v)
Inks are overprinted in the sequence of CMYK and 
then white Color.

* The image of overprinting in the sequence of white and CMYK is the same as that of overprinting in the 
sequence of white and metallic silver/CMYK on page 33. (The description of “metallic silver/CMYK” is to 
be replaced with “CMYK” only.)
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x Click .

Turn on the [Convert Spot Color] option.

 Click .

In [Operation Mode], select the operation 
of the printer. 

z Click [OK] to close the “Queue A Proper-
ties” window.

This is the end of the print job setting. To start printing, go on to page 37 “Starting the Print Operation.”
Only the settings necessary for the use of the white ink are described in this section. For other settings, refer 
to the online help provided for VersaWorks.

When You Want to Display the Side Opposite the Printed Surface by Using Clear Film. 
 P. 29
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3-2  Starting the Print Operation

Starting the Print Operation
Following the print job setting, you can start the print operation.

Procedure

 Make settings for the print job.
 P. 22, “3-1 Print Job Setting”

 Go to “Job List,” click the “Queue A” 
tab, and drag the printing data to the 
queue A job list (If the print job setting 
has been made in [Queue B], drag and 
drop the printing data on the job list of 
[Queue B].).

The contents of the data are displayed in the preview window, and the layout on the media is displayed 
in the layout window.

Areas using “RDG_MetallicSilver” 
or special metallic color (RVW-MT-
Bronze, etc.) are displayed with shad-
ing in transparent gray.

Areas using “RDG_WHITE” are 
displayed with shading in transparent 
magenta.
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 Select the print job in the job list, and then 
click .
Printing will be started.

 Printing a Metallic Color Chart
The Metallic Color Chart is the printing sample of the special metallic color. By printing the Metallic Color Chart, 
you can confirm the “complete metallic color chart” representing the special metallic color itself that can be 
printed with “Your Printer” and “Your Media” (slight pattern differences is possible to occur depending on the 
conditions of the printer and media.) By selecting colors from this color chart and creating illustrations with 
these colors, you can accurately reproduce the desired colors..

Procedure

u Make sure that you have finished making the preparations for VersaWorks, and getting 
the printer ready ( page 9, "Chapter 2 -- Getting Ready"). 

 Double-click .
Queue A Properties" window appears.

After printing, allow the ink to dry sufficiently. 
We strongly recommend performing lamina-
tion.

To continue printing similar data, repeat steps  and . Also, if you want to modify detailed set-
tings for each job, it will be convenient to perform modifications in the “Job Setting” window (which 
you can display by double-clicking the print job in the job list).
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 Click , configure the settings in [Quality-
Settings] and [Color Management].
 P. 22, “3-1 Print Job Setting”

Click [OK].

x  Click [Media] and then [Metallic Color 
Chart].

 Check the page size.
If the size of the media loaded on the printer is not 
adequate for the page size, change it to another 
media of sufficient size.

 Click [OK].
The print job of the Metallic Color Chart is added to 
the job list.

 Click .
Printing will be started.

When printing a Metallic Color Chart, the [Quality] settings from the [Queue Properties] window are 
always applied. Since you cannot change the quality settings for the job using the [Job Settings] 
window after it has been added, be sure to configure the settings in the [Queue Properties] window 
before performing the following operations.

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


40

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


Chapter 4   
Advanced

4-1  Pullback printing....................................................................42

Pullback printing (White  Metallic silver/CMYK)......................42

Pullback printing (Metallic silver/CMYK  White)......................49

4-2  Performing Texture Printing...................................................55

What is Texture Printing?............................................................55

Create The Texture Printing Data...............................................55

Performing Texture Printing........................................................61

Printing a Texture Chart..............................................................61

41

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


42 Chapter 4  Advanced Chapter 4  Advanced

4-1  Pullback printing

Pullback printing (White  Metallic silver/CMYK)
This section describes how to perform printing in the sequence of white and then metallic silver/CMYK color. 
After performing printing using white ink and allowing the ink to dry for a predetermined period, the media 
is pulled back once, and then the fill overprinting is performed using metallic silver and CMYK ink.
The printing data containing metallic colors such as "RDG_MetallicSilver" and "RVW-MT-Bronze" must be used 
in order to use the metallic silver ink, and the printing data containing "RDG_WHITE" must be used in order 
to use the white ink.

 P. 12, "Creating Printing Data"

Image of overprinting in the sequence of white and then metallic silver/CMYK

1. Printing With White Ink Only

 Make sure that you have finished making the preparations for VersaWorks, creating the 
printing data, and getting the printer ready ( p. 9, "Chapter 2  Getting Ready").

 Double-click .
"Queue A Properties" window appears.

This printing method involves some important notes for avoiding contamination on the printed 
surface. Be sure to refer to page 6, “When Performing Pullback Printing”.

You will have the print-
ed image from this side 
(the printed surface of 
the finished results).

Transparent media

White

Metallic silver / CMYK
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 Click .

For [Media Type], select "xxx[MT]: Clear 
Film" or "xxx[MT]: Clear Film, Adhe-
sive."
* “xxx” indicates “ESP-CL” and others.

For [Print Quality], select [High Qual-
ity].

With [Mode], select the print mode "White 
(v) ."
This prints with RDG_WHITE only.

 Click .

With [Other Controls], select “User Cus-
tom Settings.”

For [Dry Time], select “15 minutes.”
This is a suggested setting for when using an 
auxiliary drying unit (the DU-540).
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 Click .

In [Operation Mode], select “Print 
Only.”

Turn on the [Return to Origin After Print] 
option.

NOTE:  This section only described the settings that are necessary for the use of the white ink. For other set-
tings, refer to the online help provided for VersaWorks.

 Click [OK] to close the "Queue A Proper-
ties" window.

When You Want to Display the Side Opposite the Printed Surface

Click .

Turn on the [Mirror] option.
When the printing data with mirror im-
age is prepared beforehand, you do not 
need to turn on this option.
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 Go to “Job List” and click the “Queue 
A” tab, and drag the printing data to the 
queue A job list.

The contents of the data are displayed in the preview window, and the layout on the media is displayed 
in the layout window.

 Select the print job in the job list, then 
click  .
Printing will be started.
After printing and dry time, the media is pulled 
back. Continue printing of areas using metallic 
silver and CMYK colors.

Areas using “RDG_WHITE” are 
displayed with shading in transparent 
magenta.
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2. Printing With Metallic Silver/CMYK Color

 Double-click the print job that was used in the step 1.
The “Job Setting” window appears.

 < When performing blend print with metallic silver / CMYK >

Click .
For [Print Quality], select [High Qual-
ity].

With [Mode], select the print mode " 
CMYKMt (v) onWhite ."
This prints the areas where metallic color, such
as RDG_MetallicSilver and RVW-MT-Bronze, and
CMYK colors are specified.
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< When performing layered print with metallic silver / CMYK >

Click .
For [Print Quality], select [High Quality 
(Layered)].

With [Mode], select the print mode "Mt 
-> CMYK(v)."
This prints the areas where metallic color, such 
as RDG_MetallicSilver and RVW-MT-Bronze, and 
CMYK colors are specified.

 Click .

Turn on the [Convert Spot Color] op-
tion.

 Click .

With [Other Controls], select "Use De-
fault Media Settings."

 Click .

Turn off the [Return to Origin After Print] 
option.
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 Click [OK] to close the “Job Setting” 
window.

 Select the print job in the job list, then 
click .
Printing will be started.

After printing, allow the ink to dry sufficiently. 
We strongly recommend performing lamina-
tion.

When continuing printing using another data that uses metallic silver, white, and CMYK colors, 
repeat steps on and after 1.-. Also, if you want to modify detailed settings for each job, it 
will be convenient to perform modifications in the “Job Setting” window (displayed by double-
clicking the print job in the job 
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Pullback printing (Metallic silver/CMYK  White)
This section describes how to perform printing in the sequence of metallic silver/CMYK Color and then white. 
After performing printing using metallic silver and CMYK ink and allowing the ink to dry for predetermined 
period, the media is pulled back once, and then the fill overprinting is performed using white ink.
The printing data containing metallic colors such as “RDG_MetallicSilver” and “RVW-MT-Bronze” must be used 
in order to use the metallic silver ink, and the printing data containing “RDG_WHITE” must be used in order 
to use the white ink.

 P. 12, “Creating Printing Data”

Image of overprinting in the sequence of metallic silver/CMYK and then white.

1. Printing With Metallic Silver/CMYK Color

 Make sure that you have finished making the preparations for VersaWorks, creating the 
printing data, and getting the printer ready ( p. 9, "Chapter 2  Getting Ready").

 Double-click .
"Queue A Properties" window appears.

This printing method involves some important notes for avoiding contamination on the printed 
surface. Be sure to refer to page 6, “When Performing Pullback Printing”.

You will have the 
printed image from this 
side (the opposite side 
of the printed surface 
of the finished results).

Transparent media

White

Metallic Silver / CMYK
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 < When performing blend print with metallic silver / CMYK >

Click .

For [Media Type], select "xxx[MT]: Clear 
Film" or "xxx[MT]: Clear Film, Adhe-
sive."
* “xxx” indicates “ESP-CL” and others.

For [Print Quality], select [High Qual-
ity].

With [Mode], select the print mode " 
CMYKMt (v) underWhite."
This prints the areas where metallic color, such 
as RDG_MetallicSilver and RVW-MT-Bronze, and 
CMYK colors are specified.

< When performing layered print with metallic silver / CMYK >

Click .

For [Media Type], select "xxx[MT]: Clear 
PET Film" or "xxx[MT]: PET Clear Film, 
Adhesive" (or xxx: Clear PET Film," "xxx: 
PET Clear Film, Adhesive).
* “xxx” indicates “ESP-CL” and others.

For [Print Quality], select [High Quality 
(Layerd)].

For [Mode], select [CMYK -> Mt(v)].
This prints the areas where metallic color, such as 
RDG_MetallicSilver and RVW-MT-Bronze, and CMYK 
colors are specified.
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 Click .

Turn on the [Convert Spot Color] op-
tion.

 Click .

With [Other Controls], select “User Cus-
tom Settings.”

For [Dry Time], select “15 minutes.”
This is a suggested setting for when using an 
auxiliary drying unit (the DU-540).

 Click .

In [Operation Mode], select “Print 
Only.”

Turn on the [Return to Origin After Print] 
option.
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NOTE:  This section only described the settings that are necessary for the use of the metallic silver ink. For other 
settings, refer to the online help provided for VersaWorks.

 Click [OK] to close the “Queue A Proper-
ties” window.

 Go to “Job List” and click the “Queue 
A” tab, and drag the printing data to the 
queue A job list.
The contents of the data are displayed in the 
preview window, and the layout on the media is 
displayed in the layout window.

 Select the print job in the job list, then 
click .
Printing will be started.
After printing and dry time, the media is pulled 
back. Then, print the white areas.

When You Want to Display the Side Opposite the Printed Surface

Click .

Turn on the [Mirror] option.
When the printing data with mirror im-
age is prepared beforehand, you do not 
need to turn on this option.
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2. Printing With White Ink Only

 Double-click the print job that was used in the step 1.
The “Job Setting” window appears.

 Click .

For [Print Quality], select [High Quality].

With [Mode], select the print mode
“White (v) .”
This prints with RDG_WHITE only.
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 Click .

With [Other Controls], select "Use De-
fault Media Settings."

 Click .

Turn off the [Return to Origin After Print] 
option.

 Click [OK] to close the “Job Setting” 
window.

 Select the print job in the job list, then 
click .
Printing will be started.

After printing, allow the ink to dry sufficiently. 
We strongly recommend performing lamina-
tion.

When continuing printing using another data that uses metallic silver, white, and CMYK colors, 
repeat steps on and after 1.-. Also, if you want to modify detailed settings for each job, it 
will be convenient to perform modifications in the “Job Setting” window (displayed by double-
clicking the print job in the job list).
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4-2  Performing Texture Printing

What is Texture Printing?
Texture printing is a printing method to produce texture patterns. This uses the texture patterns of the ex-
clusive library to create and output the printing data. This document describes the texture printing using 
metallic silver ink.
*	 Create the printing data using the Adobe Illustrator version of CS or later if using Adobe Illustrator. If you 

use the earlier version before Adobe Illustrator 10 to create the printing data, the texture patterns may 
result in poor condition. 

Create The Texture Printing Data
To create the data for the texture printing, please follow the instructions below.
The program used to create the printing data is Adobe Illustrator CS4. For detailed information on drawing 
methods and how to work with palettes, refer to the documentation or online help for Adobe Illustrator 
CS4. If you're using another version of Adobe Illustrator, operations may be somewhat different from those 
explained here.

1. Open the exclusive library.

 At the swatch palette menu, select [Open Swatch Library], then [Other Libraries].
The "Select Library" window appears.
* The swatch palette is displayed by going to the menu and selecting [Window], then [Swatch].
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 Open folder in the order of [Computer] (or [My Computer]) → [Local Disk (C:)] → 
[Program Files] → [Roland VersaWorks] → [Swatch] → [Illustrator], and then select 
"Roland Metallic Texture System Library.ai."
Depending on the settings of your computer, the extension ".ai" might not be shown.

Click [Open].
The exclusive swatch libraries “Roland Metallic Texture System Library.ai“ is displayed.

By saving the ".ai" file selected in step  into the folder below, you can register the exclusive library 
to the Adobe Illustrator's library.
C:\Program Files\Adobe\Adobe Illustrator CS4\Preset\Swatch
("C" is the name of your computer's local disk.)
Once the registration is performed, you can open the library directly from the swatch palette menu, 
eliminating the need to search the file every time you start Adobe Illustrator.
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2. Create Illustrations and Specify Texture Patterns You Wish to Use

 Create the illustration.
Be sure to draw the illustration in the CMYK mode.

 Assign the desired texture patterns to the areas for the texture printing.
The areas where the texture patterns are assigned shall be printed with metallic silver ink. When the 
metallic silver ink is to be used for the printings other than the texture printing, other special spot colors 
shall be used. For the detailed usage, please refer to “Chapter 2 Getting Ready”.

*	 The name of the texture pattern is displayed on the data of Illustrator. The texture of the displayed image 
appears rougher than that of the actual print.

The area to be printed with the texture pattern
 From " Roland Metallic Texture System 
Library," specify the texture pattern such as 
"RTSL-MT-Standard-020."
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3. Create the PS (PostScript) file.

 Click [Print] from the [File] menu.

Select [Roland VW].

Click [Setup].

Click [Continue].
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 Turn on the [Print to file] option.

Click [Preferences].

Click [Advanced] in the [Layout] tab.
For Windows 2000:	 In the "Print" dialog 
box (the window at the very top of this 
page), go to the "Layout" tab and click 
[Advanced].

Click the down arrow to the right of the 
[Paper Size] box, and then click [PostScript 
Custom Page Size] from the list that ap-
pears.

For "Custom Page Size Definition," en-
ter the values in the "Width" and "Height" 
fields.
Enter values for the same size as the illustration you 
created in step 2..

 Click [OK] three times to close the "PostScript Custom Page Size Definition," "Roland 
VersaWorks Advanced Options," and "Printing Preferences" dialog boxes.
The "Print" dialog box returns.
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 Click [Print].

Click [Print].

 Specify the destination and file name for 
saving, then save the file.
Example: "TEX_print" for the folder to save to, and " 
tex.ps " as the file name

Click [Save].
The CMYK layer of the image is saved as a PS file.

 Open the folder you saved to and make sure the file has been created.
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Performing Texture Printing

Procedure

 Prepare the printing data having been created in the previous process which is de-
scribed in "Create The Texture Printing Data" on page 55.

 Make the setting to output metallic silver ink with the VersaWorks, and execute the 
printing.
To use metallic silver ink, you need to select "CMYKMt", etc. in the print mode of the VersaWorks.
For the detailed method of setting, please refer to “Chapter 3 Printing”.

Printing a Texture Chart
The texture chart is the printing sample of the texture pattern. By printing the texture chart, you can confirm 
the “complete texture chart” representing the texture itself that can be printed with “Your Printer” and “Your 
Media” (slight pattern differences is possible to occur depending on the conditions of the printer and media.) 
By selecting a pattern from this texture chart and creating the printing data using that selected pattern, you 
can print your intended pattern almost perfectly. 

procedure

u Double-click .
The [Queue A Properties] window appears.

v Click , configure the settings in [Qual-
ity Settings] and [Color Management].

Click [OK].

Note: When printing a texture chart, the [Quality] settings from the [Queue Properties] window are always 
applied. Since you cannot change the quality settings for the job using the [Job Settings] window after it 
has been added, be sure to configure the settings in the [Queue Properties] window before performing the 
following operations.
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w Click [Chart] under [Print Roland Texture 
System Library] form the [Media] menu.
This message appears: The following job will be 
printed. Do you want to continue? Check that the 
media in the printer is large enough for the displayed 
page size.

Click [OK].
The texture chart is added to the job list.

x Click .
Rip'ing and printing the texture chart are per-
formed.

* In the texture chart, color is added to part of the 
background of the texture. This makes the design of 
the texture clear.
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Message for Ink Circulation
With this machine, white ink and metallic silver ink are circulated periodically to prevent the ink precipitation. 
When the following message appears, please wait until the display changes.
[CIRCULATING INK]

In order to allow the automatic maintenance such as above to be performed, please observe the items be-
low.
 Leave the main power on at all times.
 Never leave the front cover open for long periods.
 After finishing making the settings for the various menu items, go back to the top screen.

When Dot Drop-out Etc. Cannot be Corrected
When using metallic silver ink and white ink, incorrect ink discharge, such as generation of dot drop-out, may 
occur even after cleaning is performed using the cleaning function or cleaning kit. This is due to the proper-
ties of metallic silver ink and white ink that ingredients tend to settle and separate, causing the precipitated 
ingredients to solidify after the machine is left unattended for a long period. In such cases, perform the opera-
tion described below. This operation requires two cleaning cartridges.

Procedure

 Press .
Press  several times.

 Press .
Discard the discharged fluid and attach the emptied bottle.

 Press .
 Remove the ink cartridges from slots 4 and 5.
 Insert SOL INK cleaning cartridges into slots 4 and 5.

A large amount of ink will be discharged during this operation. Perform this operation only when dot drop-out 
and other issues cannot be corrected even after performing cleaning using the cleaning function (Normal, 
Medium, Powerful) or cleaning kit. For how to perform cleaning using the cleaning function or cleaning kit, 
refer to the XC-540/XC-540MT User's Manual.

MENU
INK RENEWAL

EMPTY
        DRAIN BOTTLE

Number 4 
and 5 flashes.

Number 4 
and 5 flashes.

Chapter 5  Maintenance Chapter 5  Maintenance
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 Remove the SOL INK cleaning cartridges from slots 4 and 5.
Carry out steps  and  as many times as indicated by the 
on-screen messages.

 Insert the ink cartridges into slots 4 and 5.

 Press .
Press  to go back to the original screen.

Number 4 
and 5 flashes.

Number 4 and 
5 flashes.
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